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Some of the solutions presented in this booklet use techniques that are not included in the current CAT 

curriculum. They are presented here as alternative methods for solving the problems. It is hoped that teachers 

and participants (learners) will look at the methods used and consider using them in their Practical 

Assessment Tasks which, in a sense, are open-ended and where use can be made of techniques not included 

in the curriculum (see Assessment Criteria 6 and 10 of Phase 2 of the DBE’s 2018 PAT for Grade 12). 

A: WORD-PROCESSING 

Use the document “Water Issues in South Africa” to answer the following questions. 

 

1. What is the measurement (in cm) of the top margin of the document? (Give 

only the number without units, e.g. 9.7) 
2.4 

Method 1: 

Click anywhere in the body of the document. Select <Shift><F1> 
and the ‘Reveal Formatting’ window will open down the right-side 
of the document window (Figure 2).  

If there is nothing under ‘Section’ then click on the arrowhead to the 
left of the word ‘Section’ and some additional information will be 
displayed (Figure 1). One should note that this information includes 
information such as margin sizes, paper size, etc. The top margin 
is shown as 2.4 cm. 

 
 

 
 

 

 

 

 

 

Method 2: 

On the ‘Layout’ tab in the ribbon click on the arrowhead bottom-right of the ‘Page Setup’ group. A window 

similar to that shown in Figure 3 below opens. Note that this window contains information on the margins, 

paper and layout. The top margin is shown as 2.4 cm. 

Method 3: 

Click on the ‘Layout’ tab on the ribbon. Then select ‘Custom Margins’ right at the bottom of the ‘Margins’ 

drop-down. A dialog box will open (Figure 3) once again showing that the top margin is 2.4 cm. 

Figure 2 Figure 1 
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Figure 3 

2. What is the font size of the majority of the text in the body of the document? 

(Give only the number without units, e.g. 9.7) 
11 

Method 1: 

Unless changed all documents created using Word are based on the ‘Normal Style’ (normal.dot). 

Checking the properties of the ‘Normal Style’ shows that the default font size is 11. 

 

Figure 4 
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Method 2: 

Clicking on the ‘Home’ tab in the ribbon and checking 

the ‘Font’ group will indicate the font size (Figure 5). 

If you move the cursor around over the standard text 

in the document, which is in the majority, you will find 

that the font size is 11 pt. 

 

 

 
 
Method 3: 
 
Click anywhere in the body of the document. Select <Shift><F1> 

and the ‘Reveal Formatting’ window will open down the right-side 

of the document window (Figure 6). 

This clearly shows that the default font for the document is Calibri 

(Body) and that the size is 11 pt. 

 
 
 
 
 
 
 
 
 

 

  

Figure 5 

Figure 6 
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3. What is the width (in pts) of the border around the image ‘Figure 1. Low cost 

roof-water harvesting system’? (Give only the number without units, e.g. 

9.7) 

3 

Method 1: 

Right-click on image and select ‘Format Picture’ from 

the drop-down menu. A dialog box will open down the 

right-hand side of the document. Select the ‘Fill & Line’ 

icon on the left (the bucket) and the dialog will change to 

that shown in Figure 7. If the information on ‘Line’ is not 

visible, then click on the arrowhead to the left of ‘Line’. 

In this case one can see that the border around the 

image is black and has a width of 3 pt. 

 
 

 
 

 

 

Method 2: 

Select the image by clicking on it. A ‘Format’ tab will appear on the ribbon. Click on the arrowhead next 

to the ‘Picture Border’ icon towards the left, and then hover the mouse pointer over ‘Weight’. The drop-

down that appears will show that the weight is 3 pt. 

 
Figure 8 

Figure 7 
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4. What is the font size of the drop of water used as a bullet in the document? 

(Give only the number without units, e.g. 9.7) 
14 

Method 1: 

Left-click on the bullet. All bullets of the same type will be 

highlighted (selected). The font type and size of the bullet will be 

shown in the ‘Font’ group in the ‘Home’ tab on the ribbon (Figure 

9). You should note that the font is Wingdings and the size is 14 

pt. 

 

 

 

 

 

 

 

 

 

 

5. The image ‘Figure 1. Low cost roof-water harvesting system’ has been 

compressed for sharing purposes (i.e. sending via e-mail). What is the 

compressed resolution measurement (in ppi – pixels per inch) of the image? 

(Give only the number without units, e.g. 9.7) 

96 

Method 1: 

Select the image by clicking it. A ‘Format’ tab will open on the ribbon. On this tab click ‘Compress 

Pictures’ (Figure 10). 

 
 Figure 10 

On clicking on the ‘Compress Pictures’ option a dialog box will open (See Figure 11). This shows that the 

picture has been compressed to 96 ppi. 

Figure 9 
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Figure 11 

6. How many words are there in the third paragraph in the document, the 

paragraph which begins with ‘The requirements for water …’ (Give only the 

number without units, e.g. 9.7) 

106 

Method 1: 

Select the whole paragraph by either  

(a) triple clicking on any word in the paragraph; or 

(b) placing your mouse pointer in the left margin of the document. The cursor will change to an arrow 

facing towards the text (to the right). If you then double-click the whole paragraph will be selected.  

The Status Bar at the bottom left of the screen (Figure 12) shows that the paragraph contains 106 words 

and that there are 4349 words in the whole document. 

 

 
Figure 12 

 
Method 2: 

Select the whole paragraph by either 

(a) triple clicking on any word in the paragraph; or 

(b) placing your mouse pointer in the left margin of the document. The cursor will change to an arrow 

facing towards the text (to the right). If you then double-click the whole paragraph will be selected. 

Select the ‘Review’ tab on the ribbon. Then select the ‘Word Count’ option in the ‘Proofing’ group. A 

dialog box such as that shown in Figure 13 will open. This shows that there are 106 words in the 

paragraph. 
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Figure 13 

7. How many times is the word ‘water’ with a point size 13 found in the 

document? (Give only the number without units, e.g. 9.7) 
3 

Method 1: 

Open the advanced Find & Replace dialog box (Ctrl-H) and select the ‘Find’ tab.  

The Find and Replace dialog box can also be accessed by clicking the Replace icon in the Editing group 

on the Home tab (Figure 14). 

 

Figure 14 

In the ‘Find what’ box enter the word ‘water’ (See Figure 15). The question requires that we find whole 

words and that we should match the case. In addition, only those occurrences where the font size of the 

word is 13 pt should be counted. 

If the additional search options are not given, click on the ‘More >>‘ button. 

Make sure that the ‘Match case’ and ‘Find whole words only’ options are selected. 

Click on the ‘Format’ button at the bottom of the dialog box, then click on ‘Font’. In the ‘Font Size’ input 

box enter the value 13 and click on ‘OK’. 

Figure 15 below shows that we are looking for only those occurrences of the word ‘water’ that have a font 

size of 13. Now click on ‘Reading Highlight’ and a message indicating that 3 items matching the criteria 

have been highlighted. 
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Figure 15 

Method 2: 

Closer inspection of the smaller headings shows that they are Water-2 style headings and that the font 

size of this heading is 13 pt. Opening the dialog to modify the Water-2 style one notes that the font is 13 

pt (Figure 16). 

If you then select all 8 instances of this style in the document, you can scroll through the document and 

see that 3 of the 8 headings contain the word ‘water’. Of course if the document was hundreds of pages 

long and this would be a very time-consuming method. 
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Figure 16 

8. What is the URL of the South African Department of Water Affairs discussed 

on page 3 of the document? (Give the domain name only, e.g. 

olympiad.org.za) 

dwa.gov.za 

or any variants 

Method 1: 

Hover the mouse pointer over the hyperlinked word ‘DWA’ near the bottom of page 3 of the document. 

An information box will open showing the URL of the site to which the word is hyperlinked, in this case 

http://www.dwa.gov.za  

 
Figure 17 

 

 

http://www.dwa.gov.za/
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Method 2: 

Select the word ‘DWA’ near the bottom of page 3 of the document by double-clicking on it. Then press 

the F9-key while holding down the <Shift>-key. This action reveals the hyperlink hidden behind the 

selected word/field. The URL is clearly shown to be http://www.dwa.gov.za  <Shift>-F9 toggles between 

the field code and its resulting value. 

 
Figure 18 

Method 3: 

Select either the word ‘DWA’ or any other word close to it. Press the F9-key while holding down the <Alt>-

key. This action will reveal the hyperlinks/code hidden behind all the fields in the document. The code 

linked to the word ‘DWA’ is clearly shown to be http://www.dwa.gov.za  <Alt>-F9 toggles between the field 

code and its resulting value. 

 
Figure 19 

Method 4: 

Right click on the hyperlinked word and select Edit Hyperlink. A dialog box such as that shown in Figure 

20 opens. This dialog box contains the text that is to be displayed, viz. DWA, and the full URL of the 

hyperlinked website. 

 
Figure 20 

  

http://www.dwa.gov.za/
http://www.dwa.gov.za/
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B: SPREADSHEET 

The file called ‘Spreadsheet Dam Data Round 1’ contains a worksheet called ‘Main Data’. Use the information 

in this sheet to answer the questions that follow. The worksheet shows the volume of water in dams A to F 

for the period 1 July 2012 to 31 December 2015. It also shows the volume of water that was consumed each 

day for the same period. The volume of water present in each dam on each day is in the column with the 

heading ‘Storage ML’. This value is in millions of litres (ML or Megalitres). The next two columns for each 

dam give the water level in the dam as a percentage of its capacity - the first column the percentage on the 

given date and the next column the percentage on the same date but the year before.  

Column W is the volume of water (also in Megalitres) consumed by the population who receive the water 

from the dams in the spreadsheet. 

Use the information on the worksheet “Main Data” in the spreadsheet “Spreadsheet Dam Data Round 1” to 

answer the following questions. 

1. How many dams are listed in the worksheet? (Give only the number without units, e.g. 

9.7) 
6 

Row 2 of the worksheet shows that there are 6 dams, named A, B, C, D, E and F. 

2. What is the highest ‘current %’ for Dam C? (Give only the number without units, e.g. 

14) 
100.4 

Method 1: 

The ‘Current %’ for Dam C is in Column I. Use the MAX or LARGE functions on data in this column to 

determine the largest value. The following functions entered in say cell X4 will give the answer of 100.4 

 

 =MAX(I4:I1282) 

 =MAX(I:I) 

 =LARGE(I4:I1282, 1) 

 =LARGE(I:I, 1) 

 

 
Figure 21 

 
Figure 22 
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Method 2: 

Switch on the filters using Row 3 as the row on which the data is to be filtered. The ‘Current %’ for Dam C 

is in Column I. Click on the arrowhead next to ‘Current %’ in Column I. Use the scroll bar in the drop-down 

to scroll to the bottom of the list of values (Figure 23). You will note that the values are in ascending order 

and that the largest value, viz. 100.4, is at the end of the list. 

 
Figure 23 

Method 3: 

Switch on the filters using Row 3 as the row on which the data is to be filtered. The ‘Current %’ for Dam C 

is in Column I. Sort the data in column I in descending order (‘Sort Largest to Smallest’) using the filter sort 

(See Figure 24). 

 

 

Figure 24 

The value 100.4 is seen to be the highest value (See Figure 25). 
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Figure 25 

Method 4: 

Right click on the Status Bar at the bottom of the spreadsheet. A drop-down menu opens providing a 

number of options that can be used to customise the Status Bar (Figure 26). 

 

Figure 26 
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Click on ‘Maximum’ to activate this value on the Status Bar. Now select the cells I4 to I1282. The Status 

Bar will now show that the maximum value in the selected cells is 100.4 (Figure 27). 

 

Figure 27 

3. What is the average current percentage for Dam F for the period supplied. Give your 

answer correct to one decimal place. (Give only the number without units, e.g. 9.7) 
82.7 

Method 1: 

The ‘Current %’ for Dam F is in Column R. The following function entered in say cell X5 will provide the 

required answer, which is 82.7. 

 

 =ROUND(AVERAGE(R4:R1282),1) 

 

 
Figure 28 

 
Figure 29 

 

Method 2: 

Select all the values in Column R from R4 down to R1282 and read the average value on the Status Bar at 

the bottom right of the screen (Figure 30). 

 

 
Figure 30 
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4. What is the total capacity of all the dams? Give your answer in ML (million litres not 

litres). (Give only the number without units, e.g. 9.7) 
898 221 

The capacities of each of the dams is found in Row 1 of the worksheet. Note that the format used for the 

number is a custom format (See Figure 31). Despite the fact that the format is different to what you may 

have seen before the values are still stored as whole numbers/integers. 

 
Figure 31 

Method 1: 

Use the following function in say cell X6 to determine the total capacity of all the dams in the worksheet. 

 =SUM(B1:S1) 

 

The value 898221 is given as the answer. 
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Figure 32 

 
Figure 33 

 

Method 2: 

Select the values in cells B1 through to S1 and read the total value (sum) in the Status Bar at the bottom 

right of the screen (Figure 34). The value 898221 is given as the answer. 

 
Figure 34 

5. On how many days was the ‘Daily Water Consumption’ greater than 900 ML? (Give 

only the number without units, e.g. 14) 
590 

The ‘Daily Water Consumption’ is contained in Column W. The question requires us to count the number 

of days where the values in Column W are greater than (>) 900. 

Method 1: 

Using the COUNTIF function should give us the required answer. Enter the following function in say cell X4 

and you should get the answer 590. 

 =COUNTIF(W4:W1282, “>900”) 
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Figure 35 

 
Figure 36 

 

Method 2: 

Switch on the filters using Row 3 as the row on which the data is to be filtered. Click the arrowhead next to 

the ‘Daily Water Consumption’ heading in cell W3. In the drop-down select ‘Number Filters’ and then 

‘Greater Than …’. A dialog box will open (See Figure 37). Enter 900 in the input box and click on OK. The 

data will be filtered and only those values in Column W that are greater than 900 will be displayed. The 

number of values will be displayed on the left side of the Status Bar (See Figure 38) 

 

Figure 37 

 

Figure 38 

Remember to clear the filter when you have finished otherwise any following problems will only use the 

filtered data (See Figure 39). 
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Figure 39 

6. For Dam B the difference in the amount of water stored on the 1st and 2nd of July 

2012 was 25 ML. This means 25 ML flowed into the dam during that day. For Dam 

B, on which day was the amount of water which flowed into the dam the greatest? 

(Give your answer in the form ccyy/mm/dd, e.g. 2012/06/31). 

2013/06/03 

An additional column for building blocks will be required. Insert a column to the right of Column E. You can 

give it the heading say ‘Difference’. 

The easiest way of solving the problem is probably going to be by using filters so switch on the filters using 

Row 3 as the row on which the data is to be filtered. 

Insert the formula =E5 – E4 in cell F5. This should give you the answer 25 as indicated in the question. 

Copy this formula down to the other applicable cells in Column F. 

 

Figure 40 

 

Figure 41 

 

Now using the filters, you can either: 

Method 1: 

Use the MAX function to find the largest positive difference which is 2522. Scroll down the worksheet until 

you find 2522 and then read off the date on which this occurs. The date is 2013/06/03 
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Figure 42 

Method 2: 

If Column F were sorted in descending order, then in theory the largest positive difference should be at the 

top of the column. But therein lies a problem! 

Column F cannot be sorted in descending (or ascending) order as it contains formulas and the values used 

for sorting will automatically change during the sort. However, what you can do is to create a column to the 

right of Column F and copy just the values of the calculations into that column (Figure 43). If necessary, 

you can then delete Column F. 

 
Figure 43 

Now that you have a column of values linked to dates you can sort Column G in descending order so that 

the largest positive difference will be at the top of the sorted Column G. The value once again is 2522 and 

this occurs on 2013/06/03. 

Method 3: 

A more complicated method is to use a combination of the INDEX and MATCH functions1 that, similar to a 

VLOOKUP, allow you to search a specific column of data for a given value, but unlike the VLOOKUP can 

give you a value to the left of the given value. Remember in the VLOOKUP the value being returned is 

always to the right of the value used to search the lookup table. 

Enter the formula =MAX(F5:F1282) in cell Y5, then in any blank cell enter the formula: 

=INDEX($A$5:$A$1282, MATCH(Y5, $F$5:$F$1282, 0)) 

If the cell is formatted as ‘General’ or ‘Number’ the formula will return a value of 41428. When the cell is 

formatted as a date the value will be 2013/06/03.  

 

  

                                                 
1 See https://www.ablebits.com/office-addins-blog/2014/08/13/excel-index-match-function-vlookup/ for an explanation of how 

the MATCH and INDEX functions work 

https://www.ablebits.com/office-addins-blog/2014/08/13/excel-index-match-function-vlookup/
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C: DATABASE 

NB. Many of the database questions can also be solved by exporting the table as an Excel spreadsheet and 

then using spreadsheet functions. 

Cape Town, the Mother City, is facing the worst drought in 100 years and if Day Zero2 arrives it will be the 
first city in the world to run out of drinkable water. Currently the city has level 6B water restrictions in place, 
allowing residents to use only 50 litres of water, per person, per day. 
 
The dams in and around Cape Town form part of the Western Cape Water Supply System, which is an 

integrated and collectively managed system of dams, pump stations, pipelines, and tunnels. In addition to 

servicing Cape Town, the system supplies water to towns in the Overberg, Boland, West Coast and Swartland 

areas, and provides irrigation water for agriculture. 

Use the database “CapeTownDams1” to answer the following questions. 

 

When answering questions using a database one of the first things that you should do is to acquaint yourself 

with the structure of the database as a whole, as well as the structure of each table in the database. The 

CapeTownDams1 database includes 2 tables, viz. Dam_Details and Dam_Readings. The two tables are 

joined in a relationship, with the DamCode being the joining field (Figure 44). This could make life a lot easier 

when answering some of the questions. 

 

Figure 44 

You should note that the records in the Dam_Readings table are sorted on the ReadingCode field. 

Also note that the ReadingCode comprises two parts. The first two characters are the DamCode while the 

last 5 characters are the ReadingDate converted into a serial date number. So 2012/01/01 is stored as 40909. 

 

                                                 
2 The day on which the taps run dry. 
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1. How many ‘major’ dams are included in the database? (Give the number 

only without any units, e.g. 365) 
6 

Open the Dam_Details table in Datasheet View (Figure 45). 

 

Figure 45 

Method 1: 

The Classification field indicates whether the dam is a ‘Major’ or ‘Minor’ dam. Count the number of ‘Major’ 

dams in the table. You should see 6. 

Method 2: 

The Classification field indicates whether the dam is a ‘Major’ or ‘Minor’ dam. Click on the arrowhead next 

to Classification and select only ‘Major’ in the drop-down list (Figure 46). Only those 6 dams classified as 

‘Major’ dams will be listed. If there are a large number of dams and counting the number becomes 

problematic the Status Bar at the bottom left of the screen will tell you how many records satisfy the criteria 

(Figure 47). 

 

Figure 46 
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Figure 47 

Remember to clear the filters when you’ve completed this question. 

Method 3: 

Create a simple query based on the Dam_Details table. In your query you really only need the 

Classification field, but you could include for example the name of the dam (DamName). The criteria would 

be ‘Major’. Your query should look something like that in Figure 48 and when run will produce a list of only 

those dams that satisfy the criteria. 

 

Figure 48 

If there were too many dams to count by hand you could include the Totals (See Figure 49). 

 

Figure 49 
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2. The Land-en-Zeezicht dam in the Helderberg is a relatively new dam. On 

what date was the first reading taken and entered in the database? (Give 

the answer in the form ccyy/mm/dd, e.g. 2018/07/26.) 

2015/08/01 

The Dam_Readings table does not contain the actual name of the dam but only the dam code 

(DamCode). To answer this question, you could either make use of the fact that the Dam_Details table 

and the Dam_Readings table are linked, or you need to do two lookups if the tables were not related. 

Method 1: 

Open the Dam_Details table in Datasheet View and locate the code for the ‘Land-en-Zeezicht’ dam. To 

do this you could either scan the list, as it is short, or create a query in which the criteria in the DamName 

field could be something like ‘Like “*Zeezicht*”. You should find that the code for the Land-en-Zeezicht 

dam is LZ. 

With this code now open the Dam_Readings table in Datasheet View. Using the filter function in Access 

select only those records that have ‘LZ’ in the DamCode field. To do this click on the arrowhead next to 

the field name, deselect all the codes and then select only the code LZ (See Figure 50). 

 

Figure 50 

Only those 153 records in the table with LZ as the DamCode will be displayed (Figure 51). As the readings 

are in date order the first date shown in the filtered table will be the date on which the first recording was 

taken. If the dates are not in date order, then you could sort the DateOfReading field. This date is 

2015/08/01.  

 

Figure 51 
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Make sure that you clear the filters before continuing. If you don’t you could get incorrect answers for the 

following questions. 

Method 2: 

Instead of using the filters you could create a simple query with LZ as the criteria in the DamCode field. 

You could include the DateOfReading field in the query and then sort the records in ascending order on 

this date. (Figure 52).  

 

Figure 52 

When run the query should produce a list of all the records that satisfy the criteria with the first record 

being the date on which the first reading for the Land-en-Zeezicht was entered into the database. 

Method 3: 

Use the fact that the Dam_Details table and the Dam_Readings table are related by creating the following 

simple query (Figure 53). Note that the DamName field is taken from the Dam_Details table and the 

DateOfReading field is taken from the Dam_Readings table. 
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Figure 53 

When this query is run it should produce a list of all the records that satisfy the criteria with the first record 

being the date on which the first reading for the Land-en-Zeezicht was entered into the database (Figure 

54). 

 

Figure 54 

3. What was the volume of water in the Hely-Hutchinson dam on Table 

Mountain on 16 June 2013? (Give the number only without any units, e.g. 

365) 

931 

The Dam_Readings table does not contain the actual name of the dam but only the dam code 

(DamCode). To answer this question, you could either make use of the fact that the Dam_Details table 

and the Dam_Readings table are linked or need to do two lookups if the tables were not related. 

Method 1: 

Open the Dam_Details table in Datasheet View and locate the code for the Hely-Hutchinson dam. To do 

this you could either scan the list, as it is short, or create a query in which the criteria in the DamName 

filed could be something like ‘Like “*Hely*”. You should find that the code for the Hely-Hutchinson dam is 

HH. 
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With this code now open the Dam_Readings table in Datasheet View. Using the filter function in Access 

select only those records that have ‘HH’ in the DamCode field. To do this click on the arrowhead next to 

the field name, deselect all the codes and then select only the code HH. 

The click on the arrowhead next to the DateOfReadings field, select ‘Date Filters’ and the ‘Equals’. In the 

input box that appears enter the date 2013/06/16 (Figure 55). 

 

Figure 55 

When OK is clicked the data is filtered and it shows that on 16 June 2013 the Hely-Hutchinson (HH) dam 

contained 931 ML of water (Figure 56). 

 

Figure 56 

Method 2: 

Instead of using the filters you could create a simple query with HH as the criteria in the DamCode field. 

In the DateOfReading field the criteria should be ‘#2013/06/16#’. (Figure 57). 

 

Figure 57 
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When the query is run it will produce a similar result to that shown in Figure 56. 

Method 3: 

Use the fact that the Dam_Details table and the Dam_Readings table are related by creating the following 

simple query (Figure 56). Note that the DamName field is taken from the Dam_Details table and the 

DateOfReading field and Volume field are taken from the Dam_Readings table. 

 

Figure 58 

When the query is run it will produce a similar result to that shown in Figure 56. 

4. Give the 2-letter code of ONE of the dams where the volume of water in the 

dam NEVER exceeded the full supply capacity in the given period? 

Exclude LZ as this dam did not exist prior to 2015. 

KP 

LG 

The Percent field in the Dam_Readings table is the volume of water in the dam on the date of the reading 

expressed as a percentage of the capacity of the dam. When this value exceeds 100% then in effect the 

volume of water in the dam exceeds its capacity to hold the water. 

As the values in the Percent field are percentages we need to remember that both Excel and Access store 

these values as decimal values with 1 representing 100%. So, the criteria is going to be ‘>1’, meaning a 

volume greater than 100%. 

Method 1: 

All dams should have a value less than 100% in the Percent field and so we cannot look for those dams 

that do not exceed 100%. We could however look for the details of those dams that exceed the 100% 

capacity and see which of the dams are not mentioned in the query.  

So first let’s get the codes of all the dams in the Dam_Details table. 

AA BR DV HH KP LG LZ SL SU TW VA VV WD WH 
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Now run the query shown in Figure 59 

 

Figure 59 

When this query is run it produces a list of all the records in the Dam_Details table where the volume of 

water exceeds their capacity. Clicking on the arrowhead next to the DamCode field will produce a drop-

down showing the dam codes of all those dams that satisfied the criteria (Figure 60). 

 

Figure 60 
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On comparing this list to that shown earlier you will note that the codes KP, LG and LZ are missing. This 

tells us that the volume of water in these three dams never exceeded their capacity. The question states 

that LZ should be ignored and so the answer is either KP or LG. 

Method 2: 

Open the Dam_Readings table in Datasheet View. Using the filter arrowhead for the DamCode field select 

each dam in turn, for example AA. Each time you select a DamCode then click on the filter arrowhead 

next to the Percent field and check whether this exceeds 100%. If the dam never exceeds 100% then it 

can be included in the list of dams that satisfy the question. 

Method 3: 

Create a simple query such as that shown in Figure 61 below. Note that the data has been grouped by 

DamCode and that the maximum Percent value is shown in each case. 

 
Figure 61 

When this query is run it produces the result shown in Figure 62 which shows the maximum percentage 

for each of the dams. This clearly shows that the dams with codes KP, LG and LZ are those that have 

never exceeded their capacity. The question states that LZ should be ignored and so the answer is either 

KP or LG. 
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Figure 62 
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5. The table below is missing the column headings and a value. Analysis of 

the values in the other cells will help you to determine what the numerical 

values represent. What is the missing value? (Give the number only 

without any units, e.g. 365) 

 

Alexandra 135 

Berg River 145670 

De Villiers ? 

Hely Hutchinson 961 

Kleinplaas 1333 

Lewis Gay 172 
 

246 

This is a real problem-solving question that one sometimes comes across. You pick up a snippet of 

information and wonder how on earth the writer determined the values in the table. An interesting 

challenge! 

An approach might be to work with the data for one of the dams, say Alexandra, and find out how the 

writer got a value of 135. Once a method has been determined one then needs to check that the same 

method will provide the values next to some of the other dams. If not, then you try another method until 

you find a method which produces the desired result for each of the dams in the snippet. 

Some educated guessing also sometimes helps! The values are most likely to be volume related as none 

of the other fields gives a figure as high as 145670 (Berg River) or 1333 (Kleinplaas). 

Method 1: 

Using the DamCode field filter deselect all the dams and then select just AA (the code for the Alexandra 

dam). Now using the drop-down linked to the Volume field and moving to the bottom of the list you will 

note that the value is 135 (Figure 63) – the same value as in the given snippet. So, the hypothesis is that 

the values in the table represent the largest volume of water in each dam captured in the database. To 

test this hypothesis, we need to see whether we get a similar result for the other dams. 
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Figure 63 

On following exactly the same procedure we note that for each of the dams listed in the table the value 

given is indeed the largest volume of water in that dam. 

If we now follow the same procedure for the De Villiers dam, we note that the largest volume of water is 

246. 

6. What is the average volume of water stored in all the ‘minor’ dams for the 

year 2015? (The volume must be rounded up to the nearest whole number, 

e.g. 235.) 

313 

Method 1: 

Create a simple query that uses the Classification field from the Dam_Details table and the 

DateOfReading and Volume fields from the Dam_Readings table (Figure 64). 
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Figure 64 

On clicking <Next> you are presented with another dialog box wanting to know whether you want the detail 

or a summary. Select ‘Summary’ and then click on ‘Summary Options’. Select ‘Avg’ as the question asks 

for the average volume of water (Figure 65), click OK and then <Next>. 

 

Figure 65 
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You are now asked how you want the data to be grouped. As the question asks for the average volume 

in 2015 it makes sense to select ‘Year’ (Figure 66). 

 

Figure 66 

On clicking <Next> and the <Finish> one gets a table such as that shown in Figure 67. 

 

Figure 67 

The average volume of water in the minor dams (highlighted) is 312.5088626. When rounded up, as per 

the instruction in the question, the answer will be 313 ML. 

One could go a step further by modifying the query to only show the results for the minor dams. The result 

will remain the same. 

 

Method 2: 
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Create the query as shown in Figure 68. Note that the fields come from both tables. 

 

Figure 68 

View the query in Datasheet View. Click on the Totals button in the Records group of the Home tab (Figure 

69). 

 
Figure 69 

Then click the drop-down arrow to the left of the text Total and choose the Average function from the list 

(Figure 70). 
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Figure 70 

 
Figure 71 

The answer 312.508862629247 is displayed (Figure 71) which rounds up to 313. 

Method 3: 

Create the same query as above. Then create a report based on the query. Do not add any grouping or 

sorting to the report. 

Edit the report in Design View and add the following function to the Report Footer (or Header) (Figure 72). 

 
Figure 72 

When the report is viewed the following value is displayed in the header or footer (Figure 73). 

 
Figure 73 

This number rounds up to 313. 

NB: The RoundUp function cannot be used in Access. The function =Round(Avg([Volume]),0) will also, in 

this case, give the correct answer. 



ANNEXURE 
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Online Participants per Grade 

 

Group Name Total 

Grade 10 and below 1035 

Grade 11 1114 

Grade 12 and above 1229 

Grand Total 3378 

 

 

Average Percentage per Question per Grade 

 

Question Number 
Grade 10 and 

below 
Grade 11 

Grade 12 and 
above 

Average Per 
Question 

A1: Top Margin 35.7% 47.8% 55.2% 46.3% 

A2: Font Size 72.8% 87.0% 88.9% 82.9% 

A3: Border Width 28.0% 40.4% 51.7% 40.0% 

A4: Water Drop 66.4% 84.6% 86.6% 79.2% 

A5: Compressed 31.6% 48.1% 56.8% 45.5% 

A6: Words 61.5% 74.3% 78.8% 71.5% 

A7: Water 21.4% 19.6% 19.9% 20.3% 

A8: URL 25.8% 41.0% 47.3% 38.0% 

B1: How Many? 71.7% 84.5% 85.8% 80.6% 

B2: Highest 50.9% 65.4% 69.4% 61.9% 

B3: Average 35.7% 57.6% 65.7% 53.0% 

B4: Capacity 20.4% 30.2% 36.3% 28.9% 

B5: > 900 10.0% 32.1% 49.2% 30.4% 

B6: Inflow 1.6% 1.8% 3.4% 2.3% 

C1: Major Dams 39.9% 58.5% 63.1% 53.8% 

C2: Land-en-Zeezicht 36.9% 59.3% 64.4% 53.5% 

C3: Hely-Hutchinson 28.8% 46.6% 55.8% 43.7% 

C4: Two-letter- Code 9.7% 18.7% 23.4% 17.3% 

C5: Missing Number 3.7% 10.7% 14.9% 9.7% 

C6: Average 2.7% 4.8% 6.6% 4.7% 

Average per Grade 32.8% 45.7% 51.2% 43.2% 

 

Across the three groups the three 

• best-answered questions were: 

o A2: Font Size (82.9%) 

o B1: How Many? (80.6%) 

o A4: Water Drop (79.2%) 

 

• worst-answered questions were: 

o B6: Inflow (2.3%) 

o C6: Average (4.7%) 

o C5: Missing Number (9.7%) 


